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Trademarks 
Unigraf, UCD, UCD-422 and TSI are trademarks of Unigraf Oy. 

HDMI is a trademark of HDMI Licensing, LLC.  

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or 

other countries 

Windows® 10, Windows® 8, Windows® 7 and Windows® XP are trademarks of  

Microsoft Corporation. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf 

or its authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or 

replace, and replacement product may be new or reconditioned. Replacement product shall be 

of equivalent or better specifications, relative to the defective product, but need not to be 

identical. Any product or part repaired by Unigraf pursuant to this warranty shall have a 

warranty period of not less than 90 days, from the date of such repair, irrespective of any 

earlier expiration of original warranty period. When Unigraf provides replacement, then the 

defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf 

will provide instructions for returning the defective product. 

CE Mark 
UCD-422 products meet the essential health and safety requirements, is in conformity with and 

the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is User Manual of UCD-422, USB-connected video interface test unit for use 

with a PC with Windows® 10 Windows® 8 or Windows® 7 operating system. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of the UCD-422 units. 

• Provide instructions for the user on how to use UCD Console software. 

Product and Driver Version 
This manual explains features found in UCD Console Software Package 1.10. Please 

consult Unigraf for differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW 

and FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text 

is formatted as follows. Please read these notes carefully. 

Note This text is an important note 
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 INTRODUCTION 

Product Description 
UCD-422 is a USB 3.0 connected video interface test unit with HDMI 2.1 Pattern 

Generator and Analyzer capability. UCD Console is the common graphical user interface 

(GUI) for Unigraf’s UCD-400 and UCD-300 family units. The outlook and details of 

UCD Console will be different depending on the capabilities of the connected UCD unit 

reflecting the features enabled.  

UCD-400 family feature a high-level Software Development Kit (SDK) for use in 

automated testing. It is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system 

environment. Please refer to TSI documentation found in additional Unigraf manuals for 

more details. 

Product Features 

• High resolution video and audio capture up to 10k30Hz, 8k60Hz, 4K/UHD 120 Hz 

• Supports FRL 

• Supports Auto Low Latency Mode (ALLM) and Variable Refresh rate (VRR) 

• Compatible with HDCP versions 1.4 and 2.3 

• 2 GB on-board high-speed video buffer 

• High speed USB 3.0 host PC interface 

 

Please refer to Product Specifications in the appendix of this document for details. 

 

Functional Description 

UCD-422 units consist of a multimedia signal input stage, an internal pattern generator, a 

control stage with on-board frame buffer and a PC interface stage. In the Input Stage the 

signal is conditioned and converted to desired format. The Interface and Control stages are 

either passing the captured data directly to the USB interface or storing it to the frame 

buffer. The internal pattern generator is able to source a signal for testing sink and branch 

units. The Interface & Control stages are receiving instructions from the host PC to 

configure and control the functionality of the unit. 

Please find below logical diagram of UCD-422 unit 
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UCD-422 

The image below indicates the connections in UCD-422 unit and their description. 

Name Description 

HDMI in HDMI 2.1 compliant input from the upstream Source 

HDMI out HDMI 2.1 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

Programmer USB interface used in device FW update (behind a cover) 

Ethernet Ethernet interface used in device FW update (behind a cover) 

 

Note Capturing and sourcing high resolution video modes, especially 4K and 8K video 

modes and the 120 Hz frame rate set stringent requirements on the video cables and 

connectors.  

 

Warning In order to avoid damage to the unit and the PC, please always attach the power 

cord (Power In) to the unit first, and after that connect the USB cable to the PC. 
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Unpacking 
The UCD-422 product shipment contains: 

• The UCD-422 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• HDMI 2.1 grade HDMI cable 

• Micro-USB type B compatible cable needed for FW programming 

• Ethernet cable needed for FW programming 

Installation Package 
The UCD-422 software installation package can be obtained from Unigraf download page 

at https://www.unigraf.fi/support/download-links. Please log in with the following 

credentials before attempting to access the download page:  

Username: unigraf 

Password: ruukintie 

The installation package is a bundle between the components needed for UCD Console and 

for TSI SDK. The bundle contains the following items: 

• Windows drivers (installed during set up)  

• UCD Console software GUI (installed during set up) 

• License Manager (installed during set up) 

• TSI SDK 

• UCD-422 firmware (FW) matching UCD Console version (copied during set up) 

• User Manuals including this document. 

When launched, UCD Console verifies that the firmware (FW) version programmed to 

UCD-422 matches the launched version. If conflict, UCD Console informs the user. If FW 

update is needed please refer to Firmware Update Procedure later in this manual for 

instructions. 

Note: The software should be installed before connecting the UCD-422 unit in the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 Start the installation by running Unigraf Software Bundle Setup.exe 

Once the installer has started, a welcome page is displayed. The welcome page shows the 

software package release version. 

 Click Next to continue. The next two dialogs are used to define the installation folder in 

your PC and the Start Menu folder used.  

 When the selections are ready, click Install to start the installation. 

 Click Finish to exit the installation dialog. 

https://www.unigraf.fi/support/download-links
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 LICENSE MANAGER 

Licensing 
The features of UCD Console GUI are divided into groups based on the target use of the 

device. Some basic features can be used without licenses. Advanced feature groups have 

their dedicated licenses that open the related part of the GUI or enable the related control. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key 

enables a dedicated function in one device. Each device has its dedicated Seed Number. 

Each License Key is tied to one Seed Number. License Keys can be freely used in any 

number of PCs. 

License keys are managed with Unigraf License Manager. By default, shortcut to Unigraf 

License Manager can be found in Start Menu under: All programs/Unigraf/UCD-400. 

Please click Yes in the first dialog. License Manager can be run only with Administrator 

rights. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. If no suitable 

device families are detected, License Manager will exit. Please first select one of the 

available device families by clicking one of the device family selector buttons. 

In the list of Attached Devices please select the device in question. The serial number and 

the seed number of your device are printed in a sticker attached to the bottom of the device. 

The Back button opens the device family selection screen. The Refresh button will re-scan 

the system for installed hardware. 
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Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a 

unique Seed Number. Seed Number of the selected unit can be found in the top of the 

dialog. 

Seed Number of the selected device can be copied from dialog link for e.g. ordering 

Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to 

the boxes provided. The License Manager will automatically move the caret across the edit 

boxes during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install. The license is authenticated and if it 

is valid, the license will appear in the list of installed licenses. If the key fails to 

authenticate, an error message is displayed. If this happens, please make sure that the key 

has been typed correctly and that the seed number on the license key sticker matches the 

seed number displayed seed number for the device. 

Please note that to avoid confusion, some letters will never appear in a license key because 

they resemble numbers: For example, capital 'G' and number '6' are very similar when 

printed with small font. When in doubt, use numbers. 

Also, please notice, that characters that can't be part of valid license key are not accepted as 

input. When appropriate an automatic conversion is applied while typing: For example, 

lower case letters are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all currently installed licenses for the currently selected 

device. The list shows the actual license key, and what that key unlocks. 

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license 

and then click the Remove Selected button. 

Export will allow all installed licenses for the currently selected device to be saved into an 

INI file for backup and distribution to other PCs. To export a license, click on the license 

and then click the Export button. Please notice that licenses from multiple devices can be 

exported into the same INI file. 

Import will install licenses from an INI file for the currently selected device. 
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 FIRMWARE UPDATE PROCEDURE 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, 

UCD Configuration Utility enables the user to select the operation roles present in the 

UCD-422 unit. The utility configures a firmware set for the selected operation roles and 

programs the firmware set to the device. Please contact Unigraf for details. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the 

PC and do not power it off before the operation is completed unless specially 

requested. Avoid plugging and unplugging other USB devices when the firmware 

update is in progress. 

To update the firmware or create a new configuration on a UCD-422 device, please 

perform the following steps: 

 Connect the UCD-422 unit to a power supply and connect the USB cable. 

 Open UCD Console. Select Tools > Firmware update. 

UCD Firmware Configuration tool can alternatively be launched in Start Menu. 

The first page of the utility indicates the firmware component versions present in the 

package. Please click Next. 

 If several UCD units are connected to the PC, in next dialog please select the devices to be 

updated. Click Next.  
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Updated Modules 

The tool indicates the firmware file to be used and prompts for selection of the firmware 

modules to be updated. It compares the modules in the selected device and omits the ones 

that are the same. 

 When you are done, click Next.  

Power Cycle 

When re-initiating the firmware of a UCD device the whole process cannot be done during 

one session and the UCD device need to be restarted between steps. Therefore, on certain 

point, user needs to power cycle the device (switch off power> wait for 10 seconds > turn 

on power). 

Click OK button on the dialog. 

 

Note:  The procedure may take several minutes depending on the speed of the USB 

connection of the host PC. 
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 UCD CONSOLE 
UCD Console is the graphical user interface (GUI) of UCD-422 unit for desktop use. It 

provides the user access to all features of the unit. UCD Console includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display 

interfaces and assist in the problem detection.  

The various features of the UCD-422 are divided into tabs. Each tab contains data and 

controls for analyzing a specific feature.  

Device Selection 
A shortcut of UCD Console can be found by default under Start Menu path 

All programs/Unigraf/UCD-400. Once UCD Console GUI is launched the dialog provides 

a list of Unigraf UCD devices connected in the PC. Please select the target device by 

clicking on the appropriate button. If your device cannot be found in the list, please confirm 

the power and USB connection to the device and click the Rescan … button. 

Select Role 

The use of UCD-422 devices with UCD Console is divided in display interface specific 

roles. The structure of UCD Console varies between roles by having a varying set of tabs 

dedicated to functionalities available in the enabled role. Please find a detailed description 

of each role in the later chapters of this manual. 
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Applying Changes 

In various UCD Console dialogues the user needs to update several parameter or fields to 

make the changes needed. In order to avoid false combinations of parameters the new 

parameters are applied to UCD-422 test equipment hardware only after Apply is clicked. In 

UCD Console the situation that parameters have been changed but not applied is indicated 

by bold values of the parameter. 

Options 
Options can be found in Tools > Options. 

Video Audio and Misc. Options 

Image File Format 

You can save the captured frames either in PPM, BMP or JPG bitmap file format. In PPM 

format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 
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Audio File Format 

Audio files are stored in WAV format 

Audio Buffer size 

You can define how much memory is allocated in the PC for captured audio. Increased 

buffer size will ensure a smooth audio output but will also increase the delay between the 

capture of the audio stream and its playback. 

Folders 

Please select the directories in the PC for saving the captured images and audio, the saved 

Presets and DSC test content and DSC Work directories. 

Misc. options 

Apply color conversions to saved images: When saving captured frames, the Color Mode 

selected in Video tab will be applied also to saved images. 

Bypass 4:2:x –> 4:4:4 conversions: 4:2:2 and 4:2:0 images are previewed and stored as 

received, without pixel doubling. 

HDCP protected monitor: Text appearing if the monitor where UCD Console is viewed is 

HDCP compliant and HDCP is enabled. This feature enables preview of captured HDCP 

encrypted content in Video tab. 

DSC 

DSC Work folder: Folder for DSC Work files. 

DSC test content directory: Folder where DSC source bitmap files, related configuration 

files and DSC conversion tools are stored. 

Misc. options 

Apply color conversions to saved images: When saving captured frames, the Color Mode 

selected in Video tab will be applied also to saved images. 

Bypass 4:2:x –> 4:4:4 conversions: 4:2:2 and 4:2:0 images are previewed and stored as 

received, without pixel doubling. 

HDCP protected monitor: Text appearing if the monitor where UCD Console is viewed is 

HDCP compliant and HDCP is enabled. This feature enables preview of captured HDCP 

encrypted content in Video tab. 

TSI Integration 

Selections for generating a workspace for TSI usage. 

Enable TSI Integration: When selected, TSI Integration tool (Tools > TSI Integration) is 

enabled. When exporting test parameters in Sink / Source DUT Testing, test code is also 

appended for execution with TSI. 

Please refer to TSI Integration and Exporting Tests for TSI later in this document. 
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TSI Integration 
Tools > TSI Integration. Selections for generating a workspace for TSI usage. 

TSI Integration enables automatic creation of the necessary configuration files for 

executing tests exported from UCD Console’s Sink DUT testing or Source DUT Testing. 

Please refer to chapters Source DUT Testing Tab and Sink DUT Testing Tab later in this 

document for description about exporting tests. 

 

Detaching Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and 

controlling separate features simultaneously. To detach a tab Right-click on a tab and 

select Detach Page. To glue the tab back to the main window, click on the red Close 

button in the top right-hand corner of the window or press <Alt> + F4 on the keyboard. 
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 HDMI REFERENCE SINK 
HDMI Reference Sink dialog (HDMI RX) can be selected from the vertical tab on the left 

edge of the GUI. The horizontal tabs on the top of the GUI enable the various functions 

available. Some of the tabs are enabled by default, some only when an applicable license is 

included. HDMI RX features the following functions. 

• Video preview and saving (Video).  

• Audio monitoring and saving (Audio).  

• Status information and control of the upstream link (Link).  

• EDID editor (EDID). 

• HDCP status monitor and control (HDCP). 

• InfoFrames monitoring panel (InfoFrames) 

• Source DUT Testing 

Video Tab 
Video tab is the Preview window for the captured HDMI video. 

Input video mode 

 

The measured input resolution, frame rate and color format are shown below the preview 

window. The indication of the number of frames captured to the PC indicates the pace of 

the image data transfer to the PC. 

Disable / Enable Preview 

Click here the button to start or stop capturing video frames. 
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The top ribbon of the tab has the following controls: 

Color Mode for preview 

 

• No Conversion: The captured color components are interpreted as R, G and B 

respectively. No color conversion will be done. 

• Automatic: The color mode is selected based on the information in the MSA. If there 

is no color information available, “No Conversion” is used. 

• YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, 

and Cr respectively. Color conversion to RGB is done based on ITU-709 standard. 

• SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and 

V respectively. Color conversion to RGB is done based on SMPTE 170M standard. 

Note: Please note that the color mode selection applies to the preview window only. All 

internal functions use the raw image data as captured from the input channel. 

Save one frame 

 

Capture and save one video frame as a bitmap file in the PC. The format and storage 

location can be selected in Tools > Options pull-down menu. The available bitmap formats 

are PPM, BMP and JPG. 

The selections in Tools > Options menu define if the frame bitmap will be stored as 

captured from the display interface or if the color mode conversion selected for preview 

will be applied. 

Sequence recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered 

mode can also be enabled in this dialog. 

In buffered mode, all input frames are captured non-drop until the on-board frame buffer 

will be full. The dialog also informs the capacity of the buffer with the selected video 

mode. 

In non-buffered mode, only one input frame is buffered at a time. Frames will be skipped if 

the transfer of the data to the PC is slower than the input data rate. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 
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Snap preview 

 

When clicked, one frame of the incoming video is captured and shown in a new Snapshot 

tab. The captured bitmap can be saved with Save one frame function described above. 

Color Information of the Captured Bitmap can be evaluated by placing the mouse cursor 

on top of the preview image. The lower right-hand side ribbon of the GUI lists 

• Location of the cross cursor on the bitmap 

• The intensity of the Red, Green and Blue components of the pixel on the cursor 

location 

• The HTML HEX color code of the pixel on cursor location 

Zoom of the Preview Image can be altered by right clicking on top of the preview image 

and selecting between 

• Fit Window 

• Zoom 25% 

• Zoom 50% 

• Zoom 100% 

• Zoom 200% 

• Zoom 500% 

While in the Snap preview mode clicking on the “Camera” icon will take additional 

snapshots 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and 

recording. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the 

spectrum display is from 0 to 1/2 of the input sampling rate. The amplitude scale of 

the spectrum display can be selected between ‘Linear’ to 80 dB. 

• The horizontal sound level indicator is in the bottom of the dialog.  

The span of the preview window is defined with Audio preview size found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the 

preview window span in milliseconds (msec) and the value given in Audio preview size 

depends on the sampling frequency. Please do not exceed the Audio buffer size set in the 

same dialog. 

Disable / Enable Preview 

This button controls capturing the audio data. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device 

in the host PC through which the captured audio is played. By default, the No audio 

playback is chosen. 

Note Please note that the audio capabilities of the audio playback device of the PC are not 

automatically reflected in the audio capabilities description in UCD-422 EDID. 

Since UCD-422 is not performing any audio format conversion, it might occur that 

the source provides an audio format that the selected playback device is not 

supporting. In case a conflict occurs, please change manually the EDID content or 

disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC 

configuration. 

Audio Buffer Size 

The amount of buffering used in the data transfer between the UCD-422 unit and the PC in 

Audio buffer size in Tools > Options dialog. Increased buffer size will ensure a smooth 

audio output but will also increase the delay between the capture of the audio stream and its 

playback. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV 

(*.wav) format. The pop-up dialog defines recording duration. The folder where the audio 

file will be saved can be selected in File > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream. 
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Link Tab 
Link tab contains four panels: HPD, Link Status, FRL Control and Timing. 

HPD 

Indicator lights of the state of the cable. Cable indicates that the hardware has detected an 

upstream cable. HPD indicates that the HPD signal is Asserted (logical “high”). 

Clicking the Deassert button will cause HPD line to be set to logical “low” (de-asserted) 

and hence no HPD pulse can be generated. Click the Assert to re-activate the HPD line (set 

to logical “high”). 

Link Status 

Link Status displays the status of the link training and the link parameters negotiated 

between UCD-422 Sink and the Upstream Source. The status is updated automatically. 

LT Status: Status of the FRL Link Training State (only in FRL mode) 

FRL Mode: Lane count and link rate configuration used in FRL mode (only in FRL mode) 

TMDS Bit Clock Ratio: TMDS Bit Period / TMDS Clock Period ratio (1/10 or 1/40) (only 

in TMDS mode) 

TMDS Data 0/1/2: Indication of data flow in TMDS links 0 to 2 (only in TMDS mode) 

FRL Lock 0/1/2/3: Indication of FRL Character Lock in links 0 to 3 (only in FRL mode) 

FRL Data 0/1/2/3: Indication of data flow in FRL links 0 to 3 (only in FRL mode) 

FFE Level: Status of Feed Forward Equalizer Level that HDMI transmitter is using (only in 

FRL mode) 

FLT Update: Status of the HDMI sink’s FLT_update bit (1/0) (only in FRL mode) 

FLT No Retrain Bit: Status of HDMI Sink’s FLT_no_retrain bit (1/0) (only in FRL mode) 

FLR Error Counts: Contents of the SCDSC Error counter registers. 
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FRL Control 

Capability: Selection of the maximum link count and link rate capability of UCD-422 sink. 

Please Re-train to apply. 

FRL Start Bit: Control of the HDMI sink’s FRL_start bit (1/0) (only in FRL mode) 

FLT Ready: Status of the HDMI sink’s FLT_ready bit (1/0). Indication LED of the status. 

(only in FRL mode) 

FLT No Timeout: Status of the HDMI sink’s FLT_no_timeout bit (1/0) (only in FRL mode) 

FRL Max: Status of the HDMI sink’s FRL_Max bit (1/0) (only in FRL mode) 

LTP: Current FRL link training pattern. Click Update to re-read. (only in FRL mode) 

Additional: Input for user requested training pattern (1 – 8). Click Apply to enable request. 

(only in FRL mode) 

Timing 

Video Timing Details as retrieved from stream metadata. Frame rate is measured by  

UCD-422 Local Sink.  

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color 

components calculated by the Sink hardware. To re-calculate, click Update. Click Copy to 

store the information in Windows clipboard. 

VRR 

Indication that Variable Refresh Rate is enabled 

ALLM 

Indication that Auto Low-Latency Mode is enabled 
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EDID Tab 
EDID Tab provides tools for accessing the EDID or DisplayID of the UCD-422 Sink 

presented to the Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

• Program and read the contents of the EDID memory of the local port  

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity 

during load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all 

four blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. Hex EDID files can 

however be modified with the HEX Editor or externally generated hex EDID files 

that have Display ID content can be loaded and programmed into the hardware. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, 

it is shown in the EDID Data panel on the left hand side of the dialog. EDID contents can 

be edited by typing over the existing values. Altered content is highlighted with RED. 

Please note that Hex Editor itself does not alter the contents of the EDID data or verify its 

integrity. 

After editing the data can either be saved to an *.ecd file in the PC with Save as… or 

programmed it to the hardware EDID memory with Write. 
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EDID Editor 

EDID Editor is launched in a separate pop-up window. Please see the description of the 

EDID editor in Chapter EDID Editor later in this document. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the UCD-422 device. 

Status 

The status field indicates the HDCP status of the UCD-422 device. 

Active: The link between UCD-422 and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD-422 and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD-422 unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD-422 unit. 

Configuration 

HDCP Capable: To disable HDCP uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.4 vs. HDCP 2.3 

UCD-422 devices support by default both HDCP 1.4 and HDCP 2.3 standard. 

Note Please note that when using Fixed Rate Link mode (FRL), only HDCP 2.2 / 2.3 will 

be used. 
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InfoFrame Tab 
InfoFrame Tab displays in hexadecimal format the following received infoframes: 

InfoFrames tab displays in hexadecimal format the following received infoframes: 

• ACR (Audio Clock Regeneration) 

• ASP (Audio Sample Packet) 

• GCP (General Control Packet) 

• ACP (Audio Content Protection Packet) 

• ISRC1 (International Standard Recording Code) 

• ISRC2 (International Standard Recording Code) 

• OBA (One Bit Audio sample packet) 

• DTS (DTS Audio packet) 

• HBR (High Bitrate Audio stream packet) 

• GMP (Gamut Metadata packet) 

• EMP (Extended Metadata Packet) 

• 3D ASP (3D Audio Sample packet) 

• 3D OBA (3D One Bit Audio sample packet) 

• AMP (Audio Metadata Packet) 

• MST_ASP (Multi-stream audio sample packet) 

• MST_OBA (One Bit Multi-stream audio sample packet) 

• VSI (Vendor Specific InfoFrame) 

• AVI (Auxiliary Video Information) 

• SPD (Source Product Descriptor) 

• AIF (Audio InfoFrame) 

• MPEG (MPEG Source InfoFrame) 

• DRM (Dynamic Range and Mastering InfoFrame) 

Please click Update to re-read the InfoFrame data. 
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Source DUT Testing Tab 
The on. 

Select the tests for execution by clicking the corresponding row. 

Clicking Configure… opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. 

Please refer to chapter Exporting Tests for TSI later in this document. 

 Tests are started by clicking Run Selected. By clicking Abort the sequence is stopped. 

Test flow can be controlled with Repeats of the test sequence, Delay time between 

individual tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right 

hand side of the test panel. For each test, the matrix lists the number of occurrences of each 

result and the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties 

for viewing without UCD Console. 

By clicking Clear All the test log and the results matrix are cleared. 
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Test Parameters 

Each test set has its dedicated set of test parameters. Open a dialog for defining the 

parameters by clicking Configure…. 

Parameters of CRC Test Set 

CRC Video test parameters dialog contains fields for defining the test duration, number of 

frames captured, errors allowed and expected video format. 

Click Capture now to record Reference CRCs. Please define the number of frames used as 

reference – either one or the number of frames in the predefined test sequence.  

Exporting Tests for TSI 
Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system 

environment. Please refer to TSI documentation found in additional Unigraf manuals for 

details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab 

can be executed in TSI environment. A straightforward way is to use UCD Console’s 

Tools > TSI Integration dialog to create the necessary files for TSI environment and use 

Export function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 

 



 HDMI Reference Source  

 30.  

 HDMI REFERENCE SOURCE 
HDMI Reference Source function (HDMI TX) can be selected from vertical tab on the left 

edge of the GUI.  

The horizontal tabs on the top of the GUI enable the various functions available. Some of 

the tabs are enabled by default, some only when an applicable license is included. HDMI 

TX features the following functions. 

• Video pattern generator (Pattern Generator). 

• Audio generator (Audio Generator) 

• Status information and control of the downstream link (Link). 

• EDID editor (EDID). 

• HDCP status monitor and control (HDCP) 

Pattern Generator Tab 

Predefined Timings 

UCD-422 includes a set of common predefined video timings. Please find a list of the 

timings with their major details in Appendix C of this document. 

Color Mode 

RGB color mode with full range quantization levels will be used with all patterns except 

with Color Square Pattern. This pattern allows the user to select RGB, YCbCr 4:4:4, 

YCbCr 4:2:2 and YCbCr 4:2:0 color modes. When YCbCr is selected, the Colorimetry 

dropdown box is enabled and allows selection between ITU-709 and ITU-601. Please find a 

description of the available test patterns in Appendix D of this document. 

Color Depth 

You can set the color depth used. The available color depths are: 8, 10, 12 and 16 bpc. 

Color depth 6 bpc is only available with RGB. 
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Predefined Video Patterns 

UCD-422 has a set of predefined patterns and a possibility to user defined custom pattern. 

You can select the pattern in the provided combo box. By selecting Disabled you can have 

the links activated but no video data transferred. 

Please find a description of the available test patterns in Appendix D of this document. 

Custom Image Patterns 

BMP, PNG, JPG and TIFF files can be loaded from the PC to be used as custom images. 

The bitmaps will be aligned to the top left hand side corner, displayed at the original 

resolution, no scaling, cropped to the active area. 

To load a custom image, please click on the image in top right hand corner of the dialog. To 

enable the custom pattern, select pattern Custom Image in the pattern selector combo box. 

Pattern Generator Settings 

In order to avoid sourcing invalid video mode combinations, the new settings need to be 

validated by the user by clicking Apply. Automatic validation will be applied when Auto-

apply when valid is checked. The situation that parameters have been changed but not 

applied is indicated by bold values of the parameter. 

Note Please note that the changes in Pattern Generator tab will not be applied unless the 

user validates them by clicking Apply or when Auto-apply when valid is checked. 
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Custom Timing 

Custom Timing feature is enabled with UCD Pro for HDMI Source license. 

The timing parameters can be modified by selecting the Custom check-box and editing the 

fields of the matrix. Enable the new parameters by clicking Apply button. 

Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the 

editor by clicking Manage Timings. 

 In order to create a new custom timing based on one of the standard fixed, timings select 

the fixed timing and change its name and click Add new timing to store. 

 In order to modify an existing custom timing, select it, modify and click Update timing. 

The dialog will make a sanity check for the values entered and will warn the user for any 

combinations that cannot be used. 

Customize Timings List 

The timings are shown on the pull-down menu by un-checking the Show box. The timings 

will remain in the list and can be brought back to the pull-down menu, when needed. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in 

WAV format. 

To load internally generated audio, select Generate audio, and adjust the controls to the 

desired audio format. 

 To load an audio file from your PC, select Load audio from file, click the Open WAV 

file… button, browse and select the file and click Open 

 To play the selected audio content, click the Play  button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  
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Link Tab 
Link tab shows the status and control items for the HDMI link. 

HPD 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-

asserted (logical “low”). 

HDMI Behavior 

Selection of the HDMI version to be used. 

Status 

Mode: Indication of the HDMI/TMDS mode (HDMI/DVI) (only in TMDS mode) 

Behavior: Status of the HDMI Mode (HDMI 1.4 / HDMI 2.0 / HDMI 2.1). 

TMDS Bit Clock Ratio: Status of (TMDS Bit Period) / (TMDS Clock Period) ratio (1/10 or 

1/40) (only in TMDS mode) 

Scrambling: Status of Scrambling_Enable bit (1=LED on; 0=LED off) 

Receiver / Sink Capabilities 

Status of connected HDMI Sink device. 

Mode: Status of Max_TMDS_Character_Rate byte in the sink’s VSBD 

Behaviour: Used HDMI mode 

TMDS Bit Clock Ratio: Status of the TMDS_Bit_Clock_Ratio (1/10 / 1/40) 

FRL Support: Sink’s FRL support level as indicated in sink’s HF-VSDB 

VRR Support: Lowest frame rate and upper limit of the frame rate that sink is able to 

support using Variable Refresh Rate as indicated in sink’s HF-VSDB 

ALLM Support: Indication of Auto Low-Latency Mode support in sink’s HF-VSDB 

Error counters: Check for reading sink SCDCS error counters. Results below. 
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FRL 

Link Mode: Set the link mode used for FRL link training. 

FFE Max: Set the maximum level (0 – 3) supported for each FRL rate 

LT Timeout: The time used for FLT Timer (default = 2000 ms) 

LT Poll Timeout: Poll interval for FLT_update flag (default = 2 ms) 

Link training: Start link training with values set in this dialog. 

FLT No Retrain: Set the FLT_no_retrain bit in SCDSC Sink Configuration register of the 

connected HDMI sink 

Status 

FRL Mode: FRL Mode used by UCD-422 HDMI source 

LT Status: FRL link training status of UCD-422 HDMI source 

FLT Update: Status of FLT_update flag in SCDSC Update Flags register of the connected 

HDMI sink. 

FLT Ready: Status of FLT_ready flag in SCDSC Status Flags register of the connected 

HDMI sink. 

FRL Start: Status of FLT_update flag in SCDSC Update Flags register of the connected 

HDMI sink. 

FLT No Timeout: Status of FLT_no_timeout flag in SCDSC Source Test Configuration 

register of the connected HDMI sink. 

FRL Max: Status of FRL_Max flag in SCDSC Source Test Configuration register of the 

connected HDMI sink. 

Lane Status Matrix 

Channel lock: Status of channel lock bits in SCDSC Status Flags register of the connected 

HDMI sink 

LTP: Status of Lnx_LTP_req (x = 0 to 3) fields in SCDSC Status Flags register of the 

connected HDMI sink 

Pattern: Link Training Pattern used (0 to 8) 

FFE Level: FFE level used (0 to 4) 
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EDID Tab 

EDID tab enables analyzing and saving the EDID read from the connected Sink device. 

There are three basic functions: 

• Read the contents of the EDID of the downstream sink over the HDMI link.  

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity 

during load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all 

four blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. Hex EDID files can 

however be modified with the HEX Editor or externally generated hex EDID files 

that have Display ID content can be loaded and programmed into the hardware. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, 

it is shown in the EDID Data panel on the left hand side of the dialog. EDID contents can 

be edited by typing over the existing values. Altered content is highlighted with RED. 

Please note that Hex Editor itself does not alter the contents of the EDID data or verify its 

integrity. 

After editing the data can either be saved to an *.ecd file in the PC with Save as… or 

programmed it to the hardware EDID memory with Write. 
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EDID Editor 

EDID Editor is launched in a separate pop-up window. Please see the description of the 

EDID editor in Chapter EDID Editor later in this document. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) Status 

The status fields indicate the HDCP status of the connected UCD-422 device. 

Active: The stream between UCD-422 and the downstream sink has been encrypted. 

Authenticated: The HDCP handshake between the UCD-422 and the sink unit has been 

completed successfully. 

Authentication in process: The HDCP handshake is in process between the UCD-422 and 

the downstream sink unit. 

Keys loaded: The HDCP keys are loaded to the UCD-422 unit. 

Configuration 

Enable encryption: Check to enable the encryption of the stream between UCD-422 and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD-422 and the sink 

unit. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.4 vs. HDCP 2.3 

UCD-422 devices support by default HDCP 1.4 and HDCP 2.3. 

Note Please note that when using Fixed Rate Link mode (FRL), only HDCP 2.2 / 2.3 will 

be used. 
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 EVENT LOG 
Event Logger (Event Log) vertical tab can be seen on the left edge of the GUI. Event Log is 

enabled with UCD Pro for HDMI Sink or UCD Pro for HDMI Source license. 

Event Log dialog is divided into two panels: the left panel lists all transactions and the right 

panel shows the parsed transaction data for the line selected in the list on the left. 

With the Event Logger captures the following items  

• HPD status (HDMI TX and HDMI RX) 

• HDMI Messages 

• I2C Messages 

Each item line includes Time stamp, Type indication, Message source, and raw message 

data. The right panel lists the content of one message. Messages belonging together with 

the selected one are shown in red color.  

 Start event logging by clicking Start Capture and stop it by clicking Stop Capture. 

 The transactions can be saved in binary *.evt Event Log files by clicking Save. Saved 

Event Log files can be recalled by clicking Open.  

 Clicking Report stores event logs as html reports to be shared and viewed with any web 

browser. The save dialog allows inclusion of detailed information about the DUT and the 

test in free-text Report information.  
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 EDID EDITOR 
The EDID Editor main window is divided into three logical areas. The bottom part of the 

window contains the command buttons, and the log view. The top-left portion shows the 

currently edited E-EDID blocks in a tree-form, and the top-right portion shows an edit 

control for the currently selected item, possibly a list of sub-keys and their names (The list 

is not shown for all values) and the HEX-view of the block collection. 

Command Buttons 

Load: Load an EDID block collection file from disk. 

Save: Save the current block collection to a disk file. 

Show Hex: Show or Hide the HEX view. 

Show Log: Show or Hide the Log view. 

EDID Editor Features 

The EDID Editor currently supports VESA E-EDID block versions 1.3 and 1.4. As the 

standard defines, the versions 1.0, 1.1 and 1.2 are supposed to be backward compatible, and 

therefore the VESA E-EDID decoder will also show their contents. However, in these cases 

it should be noted that the error checking is not compliant with restrictions given in these 

older versions of the standard. In addition to VESA E-EDID block, the CEA-861 versions 

1, 2 and 3 EDID blocks are also fully supported as well as the VESA Block Map Extension 

blocks. 

Practically unlimited number of extension blocks may exist in a single collection. The 

number of blocks is limited by VESA Specifications and possibly by available system 

resources. Most EDID blocks contain a structure that is very similar to a tree-structure. The 

EDID Editor decodes each block into a tree-view of the block. The tree-view then contains 

all values contained within the EDID block. The contents can then be easily browsed, using 

only a few mouse clicks. The EDID Editor has a support for automatic variables, such as 

the block checksum. When the user changes a value in an EDID block, the tool will update 

the checksum accordingly. The automatic variables appear as read only values for the user. 

A log print will be made when an automatic variable is updated by the editor.  

HEX View: An optional HEX data display of all blocks in the collection. The view also 

shows the latest changes highlighted. 

LOG View: An optional LOG view, which will contain log prints generated by the editor. 

Mostly it will list values that have been automatically updated due to edits. 
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Editing Tips 

Editing an EDID block is very straightforward, but there are some special cases where the 

user must know how to accomplish certain types of tasks. 

• Enter key will apply text-edit values and combo-box selection. 

• To apply new setting to binary values (ones that show a check-box), please click the 

Set button. 

• When you see a Quick Config button appear below an editor, you can access a 

configuration menu that allows you to quickly select one of multiple pre-defined 

setup options. 

• In CEA-861 blocks, you can add and remove 18-byte descriptors and CEA data 

blocks by setting the values “18-byte Descriptors in this block” and “CEA Data block 

count”. Unfortunately re-arranging the descriptors and CEA data blocks is not 

supported yet, so you need to be careful when editing these. 

• Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

• You can always enter HEX or DEC, even if the value is presented as HEX, and/or 

value range is given in HEX. 

• Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

• Remember to click Set after changing a bit-value presented as a single check-box if 

you want the new value applied. 

Note It is recommended that you back up the un-edited EDID contents to a file before 

editing and writing it to the card. 

Saving EDID Data 
When you are done with editing you can either save the EDID contents to a file in the PC 

or bring it in the HEX Editor.  

For saving the data to a file in your PC click Save. 

For bringing the data to the HEX Editor close the EDID Editor window by clicking the 

Window Close button in the top right-hand corner of the window. You will be asked if you 

would like to copy and replace the EDID data in the HEX Editor. Click Yes to replace the 

data, click No to discard the modifications.  

When you are back in the HEX Editor, the bytes that the EDID Editor changed are 

highlighted with BLUE BACKGROUND. 
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APPENDIX A. PRODUCT SPECIFICATION 

UCD-422 

Input HDMI 2.1 (10K@30Hz) (HDMI Rx) 

Output HDMI 2.1 (10K@30Hz) (HDMI Tx) 

HDMI 2.1 Features FRL, TMDS, ALLM, VRR 

Content Protection HDCP 1.4, HDCP 2.2, HDCP 2.3 

Additional features eARC*, DSC*, FEC* 

Computer interface USB 3.0 

Operating System Windows 10, 8 and 7 

Software UCD Console GUI 

TSI API with interface specific Test Sets 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Mechanical Size 311 × 197 × 65 mm 

Weight 1.2 kg w/o power supply 

 

*) Please contact Unigraf for detailed availability 
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APPENDIX B. LICENSING 
In the following pages, please find detailed explanation of the functions and the licensing.  

Please refer to TSI documentation on detailed description of TSI features. 

HDMI Reference Sink (HDMI RX) 

Tab Function 

B
asic 

D
S

C
 D

ecoder 

Video    
 Preview, Capture, Snap preview ●  
 Status ●  

Audio  ●  
 Monitor, Capture and graphical preview  ●  
 Status ●  

Link  ●  
 Link Status, Link Configuration ●  

 Stream Status (video, audio) ●  
 HPD Status, HPD Assert / De-assert ●  

 DSC Decoder  ○ 

EDID    
 Read / Write, Save / Load, EDID Editor ●  

HDCP    

 HDCP 1.4 and HDCP 2.3 Support ○  
 Authentication status, Encryption status ○  

Event Log    

 Event Log ●  

Source DUT Testing     

● Feature available 

○ To be introduced later 
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HDMI Reference Source (HDMI TX) 

Tab Function 

B
asic 

D
S

C
 E

ncoder 

Pattern Generator    

 Fixed and custom Video Timings  ●  

 Fixed and custom Video Patterns ●  

Audio Generator    

 Play audio files ●  

Link     
 Link Status  ●  
 HPD Status: (Asserted / De-asserted) ●  
 Link Configuration ●  

 DSC Encoder  ○ 

EDID     

 Read / Write, Save / Load, EDID Editor ●  

HDCP     

 HDCP 1.4 Support ○  

 Control: (Enable / Disable, authenticate only,  
Encryption Enable / Disable) 

○ 
 

 Status: (Authentication status,  
Encryption status) 

○  

 HDCP 2.3 Support ○  

Event Log    

 Event Log ●  

Sink DUT Testing   ○  

● Feature available 

○ To be introduced later 
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APPENDIX C: PREDEFINED TIMINGS 

Supported FRL Lane Combination 

Description H 
active 

V 
active 

H total V total Frame 
rate 

8 bpc 
YcbCr 
4:2:0 

10 bpc 
YcbCr 
4:2:0 

12 bpc 
YcbCr 
4:2:0 

8 bpc 
4:2:2 
4:4:4 

10 bpc 
4:2:2 
4:4:4 

12 bpc 
4:2:2 
4:4:4 

VESA 800 x 600 @ 60Hz 800 600 1056 628 60    3G 3G 3G 

VESA 848 x 480 @ 60Hz 848 480 1088 517 60    3G 3G 3G 

VESA 1024 x 768 @ 60Hz 1024 768 1344 806 60    3G 3G 3G 

CTA 1280 x 720 @ 60Hz 1280 720 1650 750 60    3G 3G 3G 

VESA 1280 x 768 @ 60Hz 1280 768 1664 798 60    3G 3G 3G 

VESA 1280 x 960 @ 60Hz 1280 960 1800 1000 60    3G 3G 3G 

VESA 1280 x 800 @ 60Hz [RB] 1280 800 1440 823 60    3G 3G 3G 

VESA 1280 x 800 @ 60Hz 1280 800 1680 831 60    3G 3G 3G 

VESA 1280 x 768 @ 60Hz 1280 768 1440 790 60    3G 3G 3G 

VESA 1280 x 1024 @ 60Hz 1280 1024 1688 1066 60    3G 3G 3G 

VESA 1360 x 768 @ 60Hz 1360 768 1792 795 60    3G 3G 3G 

VESA 1400 x 1050 @ 60Hz 1400 1050 1560 1080 60    3G 3G 3G 

VESA 1600 x 1200 @ 60Hz [RB] 1600 1200 1760 1235 60    3G 3G 3G 

VESA 1600 x 1200 @ 60Hz 1600 1200 2160 1250 60    3G 3G 3G 

VESA 1680 x 1050 @ 60Hz 1680 1050 2240 1089 60    3G 3G 3G 

VESA 1680 x 1050 @ 60Hz [RB] 1680 1050 1840 1080 60    3G 3G 3G 

VESA 1792 x 1344 @ 60Hz 1792 1344 2448 1394 60    3G 3G 3G 

VESA 1920 x 1080 @ 30Hz [RB1] 1920 1080 2080 1096 30    3G 3G 3G 

VESA 1920 x 1080 @ 30Hz [RB2] 1920 1080 2000 1096 30    3G 3G 3G 

CTA 1920 x 1080 @ 30Hz 1920 1080 2200 1125 30    3G 3G 3G 

VESA 1920 x 1080 @ 60Hz [RB1] 1920 1080 2080 1111 60    3G 3G 3G 

VESA 1920 x 1080 @ 60Hz [RB2] 1920 1080 2000 1111 60    3G 3G 3G 

CTA 1920 x 1080 @ 60Hz 1920 1080 2200 1125 60    3G 3G 3G 

VESA 1920 x 1080 @ 120Hz [RB1] 1920 1080 2080 1144 120   3G 3G 3G 6G3L 

VESA 1920 x 1080 @ 120Hz [RB2] 1920 1080 2000 1144 120   3G 3G 3G 6G3L 

CTA 1920 x 1080 @ 120Hz 1920 1080 2200 1125 120   3G 3G 6G3L 6G3L 

VESA 1920 x 1440 @ 60Hz 1920 1440 2600 1500 60    3G 3G 3G 

VESA 2048 x 1536 @ 60Hz 2048 1536 2208 1580 60    3G 3G 3G 

VESA 2560 x 1440 @ 60Hz 2560 1440 2720 1481 60    3G 3G 3G 

VESA 2560 x 1080 @ 60Hz 2560 1080 3424 1120 60    3G 3G 3G 

VESA 2560 x 1080 @ 60Hz [RB] 2560 1080 2720 1111 60    3G 3G 3G 

VESA 2560 x 1600 @ 60Hz 2560 1600 3504 1658 60  3G 3G 6G3L 6G3L 6G3L 

VESA 2560 x 1600 @ 60Hz [RB] 2560 1600 2720 1646 60   3G 3G 3G 6G3L 

Other 2880 x 1440 @ 60Hz 2880 1440 2976 1456 60    3G 3G 3G 

 
3G 3 Gbps 3 Lanes 

6G3L 6 Gbps 3 Lanes 
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Supported FRL Lane Combination (contd.) 

Description H 
active 

V 
active 

H total V total Frame 
rate 

8 bpc 
YcbCr 
4:2:0 

10 bpc 
YcbCr 
4:2:0 

12 bpc 
YcbCr 
4:2:0 

8 bpc 
4:2:2 
4:4:4 

10 bpc 
4:2:2 
4:4:4 

12 bpc 
4:2:2 
4:4:4 

VESA 4096 x 2160 @ 60Hz 4096 2160 4176 2222 60 3G 6G3L 6G3L 6G3L 6G3L 6G4L 

VESA 3840 x 2160 @ 30Hz [RB1] 3840 2160 4000 2191 30    3G 3G 3G 

VESA 3840 x 2160 @ 30Hz [RB2] 3840 2160 3920 2191 30    3G 3G 3G 

CTA 3840 x 2160 @ 30Hz 3840 2160 4400 2250 30    3G 6G3L 6G3L 

CTA 3840 x 2160 @ 50Hz 3840 2160 5280 2250 50 3G 6G3L 6G3L 6G3L 6G4L 6G4L 

CTA 4096 x 2160 @ 50Hz 4096 2160 5280 2250 50 3G 6G3L 6G3L 6G3L 6G4L 6G4L 

VESA 3840 x 2160 @ 60Hz [RB1] 3840 2160 4000 2222 60 3G 3G 6G3L 6G3L 6G3L 6G3L 

VESA 3840 x 2160 @ 60Hz [RB2] 3840 2160 3920 2222 60 3G 3G 6G3L 6G3L 6G3L 6G3L 

CTA 3840 x 2160 @ 60Hz 3840 2160 4400 2250 60 3G 6G3L 6G3L 6G3L 6G4L 6G4L 

CTA 4096 x 2160 @ 60Hz 4096 2160 4400 2250 60 3G 6G3L 6G3L 6G3L 6G4L 6G4L 

VESA 3840 x 2160 @ 120Hz [RB1] 3840 2160 4000 2287 120 6G3L 6G4L 6G4L 8G 8G 10G 

VESA 3840 x 2160 @ 120Hz [RB2] 3840 2160 3920 2287 120 6G3L 6G4L 6G4L 8G 8G 10G 

CTA 3840 x 2160 @ 120Hz 3840 2160 4400 2250 120 6G3L 6G4L 6G4L 8G 10G  

VESA 5120 x 2160 @ 30Hz [RB1] 5120 2160 5280 2191 30    6G3L 6G3L 6G3L 

VESA 5120 x 2160 @ 30Hz [RB2] 5120 2160 5200 2191 30    6G3L 6G3L 6G3L 

CTA 5120 x 2160 @ 30Hz 5120 2160 6000 2200 30    6G3L 6G3L 6G3L 

VESA 5120 x 2160 @ 60Hz [RB1] 5120 2160 5280 2222 60 6G3L 6G3L 6G3L 6G4L 6G4L 6G4L 

VESA 5120 x 2160 @ 60Hz [RB2] 5120 2160 5200 2222 60 6G3L 6G3L 6G3L 6G4L 6G4L 6G4L 

CTA 5120 x 2160 @ 60Hz 5120 2160 5500 2250 60 6G3L 6G3L 6G3L 6G4L 8G 8G 

VESA 5120 x 2160 @ 120Hz [RB1] 5120 2160 5280 2287 120 6G4L 8G 8G    

VESA 5120 x 2160 @ 120Hz [RB2] 5120 2160 5200 2287 120 6G4L 8G 8G    

CTA 5120 x 2160 @ 120Hz 5120 2160 5500 2250 120 6G4L 8G 8G    

Other 5120 x 2880 @ 60Hz 5120 2880 5280 2962 60 6G3L 6G3L 6G4L 8G 8G 8G 

VESA 7680 x 4320 @ 30Hz [RB1] 7680 4320 7840 4381 30 6G3L 6G3L 6G4L 8G 8G 10G 

VESA 7680 x 4320 @ 30Hz [RB2] 7680 4320 7760 4381 30 6G3L 6G3L 6G4L 8G 8G 10G 

CTA 7680 x 4320 @ 30Hz 7680 4320 9000 4400 30 6G3L 6G4L 6G4L 8G 10G  

VESA 7680 x 4320 @ 60Hz [RB1] 7680 4320 7840 4443 60 8G 10G 12G    

VESA 7680 x 4320 @ 60Hz [RB2] 7680 4320 7760 4443 60 8G 10G 12G    

CTA 7680 x 4320 @ 60Hz 7680 4320 9000 4400 60 8G 10G 12G    

VESA 7680 x 4320 @ 100Hz [RB1] 7680 4320 7840 4529 100 12G      

VESA 7680 x 4320 @ 100Hz [RB2] 7680 4320 7760 4529 100 12G      

CTA 7680 x 4320 @ 100Hz 7680 4320 10560 4500 100       

 

3G 3 Gbps 3 Lanes 

6G3L 6 Gbps 3 Lanes 

6G4L 6 Gbps 4 Lanes 

8G 8 Gbps 4 Lanes 

10G 10 Gbps 4 Lanes 

12G 12 Gbps 4 Lanes 
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APPENDIX D: PREDEFINED PATTERNS 

Selection Pattern Description 

Disabled N/A The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed 
combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Black 

 

0% luminance 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White Vertical Stripes 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in 
pixels respectively. Default black / white = 20 / 20 pixels. 
Parameter range 0 to 5000. 

Gradient Vertical Stripes 

 

16 pixels high horizontal red green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by 
the given parameter (n). (step = n*color_depth/256). “n” 
range 0 to 5000 (default 120). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link 
Layer Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link 
Layer Compliance Test Specification. 

Color mode can be selected between RGB, YCbCr 4:4:4, 
4:2:2, 4:2:0 (ITU Rec 601 / 709) 

White Square 

 

100% intensity white square horizontally and vertically 
centered. Height and width defined by parameter as the 
percentage of height and width of the frame (default 30). 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to 
left one pixel in each frame in a sequence. The length of the 
sequence is defined with parameter. Range 0 to 34 (default is 
20) 

Custom Image 

 

Bitmap image uploaded by the user. Click on the Custom 
Images panel to browse. By default, Unigraf test image will 
be used. 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/downloads/testpatterns.html. 

http://www.icdm-sid.org/downloads/testpatterns.html
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APPENDIX E: SOURCE DUT TESTS 

CRC Based Video Test Set – HDMI RX 

CRC Based Single Reference Frame Video Test 

The test compares captured frames to a provided reference. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to 

provided parameters and after that captures frames and compares the CRC (check sum) of 

their three color components to the provided reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is 

exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz) 

▪ Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 
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CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE 

captures frames and compares their CRC (check sum) to the reference until the number of 

bad frame limit provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to 

provided parameters. After that captures frames to find a frame with matching CRC (check 

sum) of their three color components to the first provided reference. After the first 

matching CRC is found it compares the CRC of the following frames until the Number of 

frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found 

or the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz) 

• Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the 

reference frame list should be different. 
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CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times 

repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and 

Color format) to provided parameters. After that captures frames to find a frame with 

matching CRC (check sum) of their three color components to the first provided reference. 

After the first matching CRC is found it compares the CRC of the following frames until 

the Number of frames tested parameter is reached. After that it resets the list and starts from 

the first CRC. The list is repeated until timeout or until the provided number of repetitions 

is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found 

or the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz) 

• Frame rate tolerance (mHz) 

• Expected color format 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the 

reference frame list should be different. 
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